
Contents

Product Information:

Overview

How to Order
Credit Card Ordering
Purchase Orders
Check Orders (Order Form)
CompuServe Software Registration Service
Internet Ordering
Ordering from Europe

WWW Page (latest downloads available)

License Agreement
Commercial Demo Policy
Tech Support/Questions
Comments/Suggestions
How To Contact the Authors
Version History

Operation:

General Editing
How To Hex Edit: An Example

Keycuts
Command Line Usage

Layout Preferences
Display Preferences
General Preferences
Configuration Preferences

Status Bar

Page Setup
Export and Clipboard Formats
Data Viewer
Find/Replace Utility
Goto Utility
Compare Tool
Checksum Generator
Drive (Sector) Editing

Base Converter



Hex Calculator

Reference:

Windows ANSI (ASCII) Character Set
DOS Character Set
EBCDIC Character Set
Macintosh Character Set

Data Type Table



Product Overview

Hex Workshop, is a set of hexadecimal development tools for Windows 3.1, 95, and NT, combining advanced binary 
editing with the ease and flexibility of a word processor.    With Hex Workshop you can edit, insert, delete, cut, copy, 
and paste hex, print high quality customizable hex dumps, and export to RTF or HTML for publishing.    Additionally 
you can goto, find, replace, compare, and calculate checksums within a file.

Hex Workshop is integrated with the Windows Explorer, the File Manager, and Microsoft Visual C++ so you can 
quickly hex edit files from your most frequently used workspaces. Hex Workshop also includes a Base Converter for 
converting between hex, decimal, and binary, and a Hex Calculator supporting arithmatic and logical operations.

Hex Workshop was recognized in “The 47 Best from the Net” by Windows Sources and as the Windows Tech 
Journal Download of the Month.    Hex Workshop is available at retail price of $20 (with volume discounts and site 
licenses also available).    For more information, visit the BreakPoint Software Home Page at www.bpsoft.com or e-
mail inquiries to sales@bpsoft.com.
.
With Hex Workshop you can:

- Edit multiple files of unlimited size.
- Hex edit files directly from the Windows Explorer and File Manager.
- Customize your editing environment, with a multitude of user preferences.
- Print high quality hex dumps with customized headers, footers, fonts, etc..
- Cut, Copy, Paste, Insert, Delete, and Undo.
- View and Edit raw binary data as decimal values with a Data Viewer.
- Export and Copy hex as RTF and HTML for publishing or C source for inserting into source code.
- Find and Replace hex, decimal, or ASCII (incl. Unicode) values.
- Goto from the start, end, or cursor position within a file or disk.
- Use a Compare Tool to find differences in files.
- Calculate Checksums for all or part of a file. 
- Edit Floppy and Hard Disks on Windows 3.1, 95, and NT.
- Search across multiple sectors on a Disk.
- Get File/Disk properties with the click of the mouse.
- View File/Disk attributes in the Status Bar.
- Use Keycuts to access most features with function keys.
- Use Online help including multiple character tables and list of data types and ranges.
- And you get two additional applets:

1. A Base Converter to convert between hex/decimal/binary.
2. A Hex/Decimal Calculator (supporting +, -, *, /, &, ^, >>, <<, ~).

* - Version 2.50 and later run on Windows 95 and Windows NT 4.0 only (support for Windows 3.1 and Windows NT 
3.5x apply to Hex Workshop version 2.20 and earlier.



How To Order

Hex Workshop can be purchased for $20.    For this you will receive a Serial Number valid for both the 16 bit and 32 
bit versions of Hex Workshop, as well as free minor upgrades, and first notice of and discounts on major upgrades.    
For your convenience, you may order Hex Workshop from a number of sources using a variety of payment methods.  
To determine the easiest way for you order Hex Workshop select your desired method of payment below.

Payment Method:

           Credit Card  

           Purchase Order  

           Check  

           CompuServe Bill  

           Internet  

           Ordering From Europe  

Click here for multi-user prices and an order form.

Or for the latest information on Hex Workshop, check out our web page:

www.bpsoft.com



Credit Card Ordering

You may order Hex Workshop (item # 11823) from the Public Software Library (PsL) using MasterCard, Visa, 
American Express, or Discover Card by:

Phone at 1-800-2424-PSL or 713-524-6394.

FAX at 1-713-524-6398.

CompuServe Mail at 71355,470.

E-Mail at 71355.470@compuserve.com.

U.S. Mail at: Public Software Library
P.O. Box 35705
Houston, TX 77235-5705.

Internet:    To place a credit card order for Hex Workshop over the Internet, go to the BreakPoint Software 
Home Page (www.bpsoft.com) and follow the directions for placing a credit card order.

Hex Workshop Pricing:

Single Copy: $20 each

Site License:
2 to 9 machines: $17 each
10 to 24 machines: $14 each
25 to 49 machines: $10 each
50 to 99 machines: $8 each
over 100 machines: please Contact the Authors.

Prices guaranteed through 1997 and apply to Hex Workshop version 2.5 or lower.

After you register, you will receive an acknowledgment by U.S. Mail in approximately 1 week with your Serial Number.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.

BreakPoint Software cannot be reached at the numbers above.    These numbers are for PsL, a credit card order 
taking service only.

Please be sure to include your credit card number and expiration date on all credit card orders.    Any questions about
the status of the shipment of an order, refunds, registration options, product details, technical support, volume 
discounts, dealer pricing, site licenses, etc., must be directed to BreakPoint Software (see Contacting the Authors). 



Purchase Orders

You may order Hex Workshop directly from BreakPoint Software Inc. with a Purchase Order by:

U.S. Mail at: BreakPoint Software, Inc.
P.O. Box 4629
Stamford, CT 06907-4629.

E-Mail at sales@bpsoft.com.

Internet:    To submit a purchase order for Hex Workshop over the Internet, go to the BreakPoint Software 
Home Page (www.bpsoft.com)) and follow the directions for submitting a purchase order.

Purchase Orders are only accepted for orders of $50 or more and must include a purchase order 
#, billing address, and shipping address (if different from the billing address).

Payment Terms are Net 30 days

Hex Workshop Pricing:

Single Copy: $20 each

Site License:
2 to 9 machines: $17 each
10 to 24 machines: $14 each
25 to 49 machines: $10 each
50 to 99 machines: $8 each
over 100 machines: please Contact the Authors.

Prices guaranteed through 1997 and apply to Hex Workshop version 2.5 or lower.

After you register, you will receive an acknowledgment by U.S. Mail in approximately 1 week with your Serial Number.

If you require a purchase order form, use the one below:

Purchase Order #:    _________________________ (we cannot bill without a purchase order #)

Number of Copies: _________________________

Total Cost: _________________________

BILL TO ADDRESS:

Account #: ___________________________________________
Name: ___________________________________________
Organization: ___________________________________________
Address: ___________________________________________
Address: ___________________________________________



City, State, Zip: ___________________________________________
Country: ___________________________________________

Phone(s): ___________________________________________

E-Mail Address: ___________________________________________

SHIP TO ADDRESS (if different):

Name: ___________________________________________
Organization: ___________________________________________
Address: ___________________________________________
Address: ___________________________________________
City, State, Zip: ___________________________________________
Country: ___________________________________________



Check Orders

You may order Hex Workshop directly from BreakPoint Software Inc. with a check by:

U.S. Mail at: BreakPoint Software, Inc.
P.O. Box 4629
Stamford, CT 06907-4629.

Payments must be in U.S. dollars drawn on a U.S. bank, or with an international postal money orders in U.S. dollars

After you register, you will receive an acknowledgment by U.S. Mail in approximately 1 week with your Serial Number.

Please fill in the information below:

Single Copy: $20 each

Site License:
2 to 9 machines: $17 each
10 to 24 machines: $14 each
25 to 49 machines: $10 each
50 to 99 machines: $8 each
over 100 machines: please Contact the Authors.

Connecticut residents add 6% sales tax ________

Total payment ________

Prices guaranteed through 1997 and apply to Hex Workshop version 2.5 or lower.

Name: ___________________________________________
Organization: ___________________________________________
Address: ___________________________________________
Address: ___________________________________________
City, State, Zip: ___________________________________________
Country: ___________________________________________

Phone(s): ___________________________________________

E-Mail Address: ___________________________________________

Where did you hear about Hex Workshop? ________________________

Comments:



CompuServe Software Registration Service

To order from CompuServe follow the steps below and CompuServe will automatically add the Hex Workshop 
registration fee to your next bill.

1. Connect to CompuServe.
2. Go to the Shareware Registration Service (GO SWREG).
3. Choose "Register Shareware".
4. Enter the appropriate responses.
5. When prompted with the search window, use the keyword: HEXWORKS.
6. Select the appropriate product/license and choose "Register".

Hex Workshop products/licenses offered include:

Hex Workshop Single User License $    20 Registration ID: #7813
Hex Workshop (2 pack) $    34 Registration ID: #14201
Hex Workshop (5 pack) $    85 Registration ID: #14202
Hex Workshop (10 pack) $140 Registration ID: #14203
Hex Workshop (25 pack) $250 Registration ID: #14204

After you register, you will receive an acknowledgment by U.S. Mail in approximately 1 week with your Serial Number.

Any questions about the status of the shipment of an order, refunds, registration options, product details, technical 
support, volume discounts, dealer pricing, site licenses, etc., must be directed to BreakPoint Software (see 
Contacting the Authors). 



Internet Ordering (Internet)

Hex Workshop can be ordered using a variety of payment methods over the Internet.

To order over the Internet, first go to the go to the BreakPoint Software Home Page (www.bpsoft.com) and follow the 
directions for submitting an order over the Internet.

Hex Workshop Pricing:

Single Copy: $20 each

Site License:
2 to 9 machines: $17 each
10 to 24 machines: $14 each
25 to 49 machines: $10 each
50 to 99 machines: $8 each
over 100 machines: please Contact the Authors.

After you register, you will receive an acknowledgment by U.S. Mail in approximately 1 week with your Serial Number.

Any questions about the status of the shipment of an order, refunds, registration options, product details, technical 
support, volume discounts, dealer pricing, site licenses, etc., must be directed to BreakPoint Software (see 
Contacting the Authors)



Ordering From Europe

You may order Hex Workshop (program #100130) from ShareIt, an order taking service in Europe, using 
EuroCheque, Eurocard/Mastercard, American Express, or Diners Club by:

Phone at 49-221-2407279 or 49-172-7229837.

FAX at 49-221-2407278.

E-Mail at register@shareit.com.

Internet:    To place an order for Hex Workshop over the Internet, go to the BreakPoint Software Home Page 
(www.bpsoft.com) and follow the directions for placing an order.

Hex Workshop Pricing:

Single Copy: $20 each

Prices guaranteed through 1997 and apply to Hex Workshop version 2.5 or lower.

After you register, you will receive an acknowledgment by U.S. Mail in approximately 1 week with your Serial Number.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.

BreakPoint Software cannot be reached at the numbers above.    These numbers are for ShareIt, a credit card order 
taking service only.

Please be sure to include your credit card number and expiration date on all credit card orders.    Any questions about
the status of the shipment of an order, refunds, registration options, product details, technical support, volume 
discounts, dealer pricing, site licenses, etc., must be directed to BreakPoint Software (see Contacting the Authors). 



WWW Page - Latest Downloads Available

The BreakPoint Software home page is:

www.bpsoft.com

From our home page you can download commercial demos of the latest 16 and 32 bit versions of Hex Workshop, 
download betas of upcoming versions, and find out the latest information on improvements and plans for future 
releases.    We also have links to other development resources, software development companies, and download 
sites on our web site.

From our web site you can find the most up to date information on ordering Hex Workshop over the Internet (Ordering
over the Internet) 

Note:    The WWW home page is subject to change.    If possible we will provide the new URL if this one changes for 
any reason.



License Agreement

Hex Workshop Copyright © 1995-97, BreakPoint Software, Inc.
All Rights Reserved.

License Agreement

You should carefully read the following terms and conditions before using this software.

DISCLAIMER

Users of Hex Workshop must accept this disclaimer of warranty: "Hex Workshop is supplied as is.    BreakPoint 
Software Incorporated disclaims all warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose.    The author assumes no liability for damages, direct or consequential,
which may result from the use of Hex Workshop."

DISTRIBUTION OF HEX WORKSHOP - COMMERCIAL DEMO

The commercial demonstration version of Hex Workshop cannot be distributed without the expressed permission of 
BreakPoint Software Incorporated.    Anyone wishing to distribute the demonstration version of Hex Workshop must 
first contact BreakPoint Software Incorporated for authorization.

INTELLECTUAL PROPERTY

This program is owned by BreakPoint Software Incorporated and is protected by U.S. and international copyright 
laws.    Violation of this copyright is a serious offense VIOLATION OF COPYRIGHT IS A SERIOUS OFFENSE

USER LICENSE

You may use this program only on a single computer.    This program is the property of BreakPoint Software 
Incorporated, and is protected by U.S. and international copyright laws.    VIOLATION OF THIS COPYRIGHT IS A 
SERIOUS OFFENSE, PUNISHABLE BY THE UNITED STATES GOVERNMENT.



Commercial Demo Policy

Beginning with version 2.50, the trial policy for Hex Workshop was changed from a shareware version (unlimited) to a
commercial demo version (limited time).    Hex Workshop (version 2.50 and later) is offered for a 90 day trial period 
with unlimited functionality.    After the end of the trial period the user is granted an additional 14 days to order and 
receive delivery of the full version of the product.    The full version of Hex Workshop costs $20, and is available from 
a number of sources for your convenience (Ordering Hex Workshop).

If a longer trial period is required, you may download version 2.20 from the BreakPoint Software Web Site 
www.bpsoft.com.    This version has an unlimited trial period (shareware style).

If you have any questions regarding this policy or on purchasing the full version of Hex Workshop, contact the 
authors.



Technical Support and Questions

Technical Support for Hex Workshop will be provided to registered users only.    If you require technical support or 
have found a problem with Hex Workshop please submit it as an e-mail to support@bpsoft.com.    Please be as 
descriptive as possible and title the message "Hex Workshop: Tech Support" or "Hex Workshop: Problem Reported" 
as applicable.    We will make every effort possible to answer all inquiries (problems reported) in a timely manner.

In either case please specify the version information located in the About Box (i.e.: ver 2.50, 32 bit) and the operating 
system (Win 3.1, 95, or NT) you are using.

For additional information, see Contacting the Authors.



Comments and Suggestions

We are continually planning our next versions, in which we will be adding features to the Hex Editor as well as 
additional hex-related mini-applications.

If you have any comments or suggestions for the current version or future versions of Hex Workshop please do not 
hesitate to contact us via e-mail at support@bpsoft.com.    Please title the message "Hex Workshop: Comments (or 
Suggestions)".

For additional information, see Contacting the Authors.



How To Contact the Authors

The Authors can be contacted via online services or directly by mail.

E-Mail Address: Internet at sales@bpsoft.com or support@bpsoft.com
CompuServe at 75554,377

U.S. Mail: BreakPoint Software, Inc.
P.O. Box 4629
Stamford, CT 06907-0629



Version History

Hex Workshop v 2.50 (32 bit only) - Jan 1997 (current version):

NEW FEATURES

Installer is now a self extracting archive.

Added Data Watch to display and edit decimal values.

New Preferences
- Added user defined bytes/row and Fit to Window.
- Added new character filters (DOS and Macintosh).

Redesigned Preferences tabs.

Redesigned Document Properties (offset, insert/overwrite, etc.).

Added Shift-PgUp and Shift-PgDn Accelerators.

Find Improvements
- ASCII search by Unicode.
- Ability to pad replacement ASCII strings with nulls.
- Ability to search by decimal value (byte, long, float, etc.).

                            Added Copy As and Export capabilities (Text, HTML, RTF, and C Source).

BUG FIXES

Inserting bytes would occasionally cause crashes

Miscellaneous display problems

Did not handle read only files properly

Did not save checksum dialog states

Canceling a “Save As” caused Altered bytes to be reset

Hex Workshop v 2.20 - July 1996:

NEW FEATURES

Added Installer.
Creates Hex Workshop Program Group.
Installs the Hex Workshop File Manager Extension.
Installs the Hex Workshop Windows 95 Shell Extension.
Adds Hex Workshop to Microsoft Visual C++ "Tools" Menu.

Added Uninstall capability to 32 bit version to remove product.

New Preferences
- Default path to open files from.
- Can set to open documents maximized.
- Can choose to highlight altered bytes with a different color.
- Added new character filters (EBCDIC/ASCII/none).



Added new keycuts for selecting bytes.

Added Command Line options.

BUG FIXES

Right Aligned Footer not working properly.

16-bit Checksum sign extension bug.

Able to handle unlimited size files although performance on very large files is poor.

Preferences were not being saved in some cases.

Base Converter always pasted into one window.

Hex Workshop v 2.10 - Feb 1996:

NEW FEATURES

Page Setup
- Margins, Headers, Footers, Printer Font.

Enhanced Disk Editing 
- Support more drive types.
- Edit in drive or raw disk mode.

Context Menu Extension [Win 95]
- Can hex edit a file from the right mouse context menu.

Drag and Drop
- from shell/explorer [Win 95].
- from File Manager.

File Manager Extension
- Allows user to add a "hex edit" menu to file manager.

Checksum
- Added 16 bit checksum.
- Added one's and two's complement modifiers.

Enable paste into Find/Replace, Goto dialogs.

Added Tool Help Bubbles.

Added Dockable Toolbars (32 bit version).

Combined Hex Calculator and Bit Calculator into one.

BUG FIXES

Printing continued for infinite number of pages .

Editing disks with over 255 tracks didn't work.

Sector find wasn't working properly.

Compare failed when file comparing two files with the same file name.

Never performed input range checking for the compare and sector dialogs.



Dialog background colors where not being set correctly in Win 95.

Goto dialog was not always setting the initial focus properly.

Hex Workshop v 2.01 -    Dec 1995

BUG FIXES

Signed short was not working properly in the 32-bit version.

Launching the calculators failed because of new naming convention.

Hex Workshop v 2.00 - Oct 1995

NEW FEATURES

32 bit version for Windows 95 and NT.

Sector Editor
- Supports BIOS floppy and hard disks.

Checksum calculations
- Checksum, CRC-16, CRC-16/CCITT, CRC-32 are calculated selection.

Right-Click menus
- Cut, Copy, Paste, Goto, Checksum, Insert for Files
- Copy, Next Sector, Previous Sector, Goto, Checksum for Disks.

Paste Special Command
- Allows you to paste any format on the clipboard into Hex Workshop.

New File Command
- Allows you to open a blank file (useful with paste special).

Copy Special Command
- Places the selected text on the Windows clipboard in a text format.

Select Block
- Allows you to select large amounts of data easily (by block size or ending offset).

BUG FIXES

Improved display
- Optimized the selection drawing routines.
 

Fixed crash when trying to open a help component that didn't exist. 

Print/Print Preview was calculating the number of lines per page incorrectly.

Could not add (append) to the end of a file.

Find Again failed, when changing the cursor position between finds.

When saving documents, was not clearing undo stack.

Copy/Pasting selection over 32K causes random results.



Hex Workshop v 1.0 - May 1995

ORIGINAL VERSION



General Hex Editing

Hex Workshop includes a professional hex editor with the power and ease of a Word Processor allowing cut, copy, 
paste, insert, delete, undo, and more.

Hex/ASCII Editing:

A file can be edited from either the hex or ASCII display.    The cursor can be toggled between hex and ASCII with the 
tab key or hex/ASCII can be chosen by clicking the mouse in the particular region.

Clipboard Functionality:

Cut (Ctrl+X), Copy (Ctrl+C), and Paste (Ctrl+V) operate in a similar manner to other editors.    Paste Special allows 
you choose from and paste any of the standard Windows Clipboard formats currently available into a file.

Undo:

Undo (Ctrl+Z) allows you to reverse the most recent editing operation(s).    The size of the undo buffer (which 
determines how many operations are saved) can be set in the General Preferences.

Inserting/Deleting:

Automated Inserting (Ctrl+Ins) allows a specified number of bytes to be inserted at the cursor position with any hex 
value. Deleting (Del) simply deletes the highlighted bytes.    Normal editing can be done in either insert (INS) or 
overwrite (OVR) mode.    Insert mode with automatically insert hex values entered at the cursor position, while 
overwrite mode will overwrite existing bytes at the cursor position with hex values entered.    The current mode is 
shown in the far right pane of the status bar and is toggled with the insert (Ins) key.

Select Block/Select All:

A block of hex can be automatically selected at the cursor position using the Select Block feature and specifying 
either the size of the block or the ending position.    In either case the block starts at the cursor position.    Select All 



(Ctrl+A) automatically selects the entire file.

File/Disk Properties:

File/Disk Properties (Alt+Enter or Right Mouse Button) display information on the current file or disk being edited.

Window Operations:

Open windows can be tiled Horizontally (F2), Vertically (Alt+F2), or Cascaded (Ctrl+F2) from the Window Menu or 
using keycuts.

The editing environment can be customized using Layout and Display preferences for font, colors, and hex display 
(bytes per column). 



How To Hex Edit: An Example

This topic is designed as an example of how to hex edit (modify) a file.    It is intended for those who are not familiar 
with binary file editing and would like to make a specific change in a binary file.    An example of where this technique 
would apply is in game cheats.    To implement a game cheat, users are typically instructed to make a change in a 
saved game file in order to get loads of extra cash or a super weapon.

Making these changes is extremely easy with Hex Workshop.    Simply perform the following stpes:

1.    Open the file you wish to modify

L:aunch Hex Workshop and from the file-open menu choose the specific file.

2.    Finding what you need to change

This is the most difficult part when performing binary file editing.    You will be typically given instructions in one of two 
forms:

“Go to offset xxxx” or “Search for the value yyyy”

Going to a specific offset

In Hex Workshop, under the Edit menu, select Goto.

Fill in the offset given in the instructions.    Make sure that the “Beginning of File” and “Hex” radio buttons 
are checked.    Hit the “Go” button.    Hex Workshop will then move the cursor to (or goto) a certain 
hexadecimal address (offset) from the beginning of the file.

Although it is unlikely, you may be given a decimal offset.    If this is the case, the instructions will tell you this
specifically.    In this case, make sure you check the “Dec” radio button for decimal.

Search for a Hex String

In Hex Workshop, under the Edit menu select Find.



Fill in the search string given in the instructions.    Make sure that “Hex” and “Down” radio buttons are checked.    Hit 
the “Find Next” button.    Hex Workshop will then search for the hexadecimal string from the beginning of the file.

NOTE: Your data will be selected in Hex Workshop editor, please deselect it by clicking the mouse just to the left of 
the selection.

3.    Making the Change

Before you make any change, make sure you are in overwrite mode and not in insert mode.    You can tell what mode 
you are in by looking at    the indicator in the right side of the Status Bar, located at the bottom of the editor.    It is 
encircled in red in the graphic below for demonstration purposes.

If the indicator says “INS” instead of “OVR” hit the “Insert” key on your keyboard once to toggle Hex Workshop into 
overwrite mode.

Now, you are ready to change the value.    In most cases you will be instructed to change some hex string to another.  
For example, “Change C705 to FFFF”.    If your instructions say to change 0xC607 to 0xFFFF, please ignore the 0x- 
this is a shorthand for saying hexadecimal.

You can see on the 2nd line (at offset C705) the text you would like to change.    You would now move the cursor to 
the “C” and type “FFFF”.

You can see your changes in red.    (If they do not appear in red, go under the Options-Preferences menu, click on the
“Display Tab” and select the “Highlight Modified Bytes” checkbox.

4.    Saving the File

The last step is to save the file.    You can do this by going under the “File” menu and selecting “Save”.    You will be 
prompted with the following dialog (unless you specifically turned it off):

We recommend that you hit “Yes”,    so if you made any mistakes, you can recover the original file.





Keycuts

Below is a list of Keycuts available:    

F1 Help (Contents)
F2 Tile Windows Horizontally
Alt+F2 Tile Windows Vertically
Ctrl+F2 Cascade Windows
F3 Find Again
Alt+F3 Find
Alt+F4 Exit
F5 Goto Again
Alt+F5 Goto 
F6 Compare Again
Alt+F6 Compare
F12 Generate Checksum

Alt+Enter Properties of File/Sector

Tab Toggles between Hex and ASCII in main edit window

Home Beginning of File/Sector
End End of File/Sector

Shift+Right Arrow Selects +1 byte forward from cursor
Shift+Left Arrow Selects -1 byte backward from cursor
Shift+Down Arrow Selects 16 bytes forward from cursor
Shift+Up Arrow Selects -16 bytes backward from cursor
Shift+PgDn Selects 1 screen length forward from cursor
Shift+PgUp Selects 1 screen length backward from cursor
Shift+Home Selects from cursor position to begin of document
Shift+End Selects from cursor position to end of document

Ctrl+Up Previous Sector (Drive Editing Only)
Ctrl+Dn Next Sector (Drive Editing Only)
Ctrl+PgUp Back 10 Sectors (Drive Editing Only)
Ctrl+PgDn Ahead 10 Sectors (Drive Editing Only)
Ctrl+Home First Sector (Drive Editing Only)
Ctrl+End Last Sector (Drive Editing Only)



Command Line Usage

Hex Workshop allows users the ability to open files, logical drives, and raw fixed disks via the command line

Usage:

    hworks32 [files...] [drives...] [/F:fixeddisk]

    files     - Opens the listed file(s).
    drives    - Opens a Logical Drive.  In the form 'X:', where X is
                the drive letter.
                  A: for Drive A:
    fixeddisk - Open a "Raw Mode" Fixed Disk in the Form '/F:x',
                where x is the fixed disk number:

  /F:80 for the first fixed disk
  /F:81 for the second fixed disk

Examples:

c:\hexworks\hworks32 foobar1.bin foobar2.bin

This will start Hex Workshop with the files "foobar1.bin" and "foobar2.bin" loaded in the editor.

c:\hexworks\hworks32 C:

This will start Hex Workshop with the logical "C:" drive loaded in the sector editor.

c:\hexworks\hworks32 /F:80

This will start Hex Workshop with the physical first physical disk loaded in the sector editor.

Note:    The above usage and examples are for the 32 bit version of Hex Workshop.    For the 16 bit version the 
program name is hworks16 (not hworks32).



Layout Preferences

Hex Workshop provides the user with preferences to customize the appearance of their hex editing environment.    
Below are a list of these options:

Rows:

Hexadecimal data is displayed in rows.    The amount of bytes per row can be set to a specific value (8, 16, 24, or 32 
bytes) or can be set to fit to the editor window width.    The default is 16 bytes per row.

Columns:

Within the rows, data is broken up into columns to make viewing the data easier.    The Column preference lets the 
user choose how this data is grouped.    For example, if data is grouped in 4 bytes (or longs), there would be four 
columns of 4 bytes in each row of hexadecimal data (assuming 16 bytes per row).    The default is 2 bytes (or shorts).

See also: Display Preferences, General Preferences, Configuration Preferences



Display Preferences

Hex Workshop provides the user with preferences to customize the appearance of their hex editing environment.    
Below are a list of these options:

Colors:

Different colors are used to display the File Offsets, Odd Columns (of data), Even Columns (of data), (ASCII) 
Characters, and Modified Bytes.    These colors can be customized by the user.    The defaults are black, light blue, 
dark blue, black, and red for the file offsets, odd columns, even columns, characters, and modified bytes, 
respectively.

Highlight Modified Bytes:

If this is set Hex Workshop will display modified bytes in the specific color selected (see Colors, above).    The default 
is off.

Font:

The font which is used to display all data in the main editing window.    This can be changed to any monospace font 
on the users system.    The default is Courier 12 point.

Character Set:

On the right side of the main editing window is the character equivalent of the hexadecimal data.    The characters are
interpreted using a chosen character set.    The user can choose between ASCII (0x20-0x7F), Windows ANSI (no 
filtering), and EBCDIC.    The default is ASCII.

See also: Layout Preferences, General Preferences, Configuration Preferences



General Preferences

Prompt for Backup when Saving:

When set Hex Workshop will ask if a backup should be created whenever an altered file is being saved.    A backup 
file with the extension *.BAK will be created if requested.    Default is on.

Warning on Insertion/Deletion:

When set Hex Workshop will post a warning message (dialog box) before allowing an insert or delete of bytes in an 
open file.    Default is on.

Notification of Goto/Find/Compare Wrapping:

When set Hex Workshop will prompt the user whether or not to wrap the file (move from the end to the beginning or 
vice-versa) during the Goto, Find/Replace, or Compare Operations.    Default is on.

Open Documents Maximized:

When set Hex Workshop will always open files or disks with their editing Window maximized.    Default is off.

Use ToolTips:

When set Hex Workshop displays tool tips for the toolbar buttons when the cursor is positioned over the buttons.    
This helps define the function of each toolbar button.    Default is on.

Size of Undo Buffer:

Specifies the size of the buffer used by Hex Workshop for maintaining a list of previous editing operations.    This is 
used when the undo command is selected, the larger the buffer the more operations which can be saved and later 
undone if requested.    Default is 4K.

Starting Directory:

This is the directory which Hex Workshop will use as a default when opening files.    Default is none (the application 
directory).

See also: Layout Preferences, Display Preferences, Configuration Preferences





Configuration Preferences

Hex Workshop provides the user with settings to integrate hex editing closely with the operating system to allow the 
quick and easy launching of Hex Workshop.    These setting can be customized from the Options-Preferences menu 
in the Configuration tab.    Below are a list of these options:

Add Hex Edit Item to Right Mouse Context Menu (Win 95 and NT 4.0 only):

When set Hex Workshop will install a Windows 95 Context Menu Shell Extension so whenever the right mouse button
is clicked on a file, a Hex Edit menu item will be added.    Clicking on the Hex Edit menu item will automatically launch
Hex Workshop with the selected file(s) open.    There is no default setting, the user is prompted for this option on first 
use of the product.

Add Hex Edit Menu to File Manager (Win 3.x, 95, NT):

When set Hex Workshop will install a File Manager Extension adding a Hex menu to the File Manager.    Clicking on 
the Edit File(s) menu item under the Hex Menu will automatically launch Hex Workshop with the selected file(s) open. 
There is no default setting, the user is prompted for this option on first use of the product.

Allow Multiple Instances (32 bit only):

When set Hex Workshop allow multiple instances to be running at once.    If this is not set, then launching Hex 
Workshop from anywhere will result in the maximizing of the previous running instance with the selected files open if 
appropriate.    Default is off.

See also: Layout Preferences, Display Preferences, General Preferences



Status Bar

The Status Bar displays information on the current file (or disk sector) and editing environment.

The first pane of the status bar contains information on the current operation (or menu item). 

The second pane of the status bar contains the cursor position, displayed in either hex or decimal (as selected in the 
Options-File Offset Menu).

The third pane contains information on the data at the cursor position or being highlighted.    If no data is highlighted, 
Hex Workshop interprets the data at the cursor in the data format selected in the Options-Status Bar Data Menu.    If 
hex data is highlighted, Hex Workshop will interpret the data appropriately depending on the amount of bytes 
highlighted (i.e. 2 bytes as a Short).    If an appropriate data type does not exist (an odd number of bytes is 
highlighted, i.e. 9), Hex Workshop will display the number of bytes being highlighted.

The contents of    the fourth pane depends on whether a file or disk is being edited.    If a file is being edited, the pane 
contains the file size in bytes, displayed in either hex or decimal.    If a disk is being edited, the pane contains the size 
in bytes of the sector being edited.

The last pane displays whether Hex Workshop is currently in overwrite mode (OVR) or insertion mode ("blank"). 



Export and Clipboard Formats

Hex Workshop includes the capability to both export and copy hex as formatted text (RTF), text, and HTML, for 
publishing, and C source for inserting into code for development.    Exporting is done using the File-Export Menu and 
copying to the Windows Clipboard is done using the Edit-Copy As Menu.    Below are samples of the different formats:

Formatted Text (RTF):

00000000 4D5AC600 B6000000 15040100 FFFF0000 MZ............
00000010 00000000 00010000 1E000000 01000000 ..............
00000020 00000000 00000000 00000000 00000000 ..............
00000030 00000000 00000000 00000000 00000000 ..............

Text:

00000000 4D5AC600 B6000000 15040100 FFFF0000 MZ..............
00000010 00000000 00010000 1E000000 01000000 ................
00000020 00000000 00000000 00000000 00000000 ................
00000030 00000000 00000000 00000000 00000000 ................

HTML:

<html>

<head>
<title>

HWS5383
</title>

</head>

<body bgcolor="#FFFFFF">
<h1><center>HWS5383</center></h1>
<meta name="GENERATOR" CONTENT="Hex Workshop">
<hr>

<pre><code>
<font color="#000000">00000000 </font><font color="#0000FF">4D5AC600 </font><font 
color="#004080">B6000000 </font><font color="#0000FF">15040100 </font><font color="#004080">FFFF0000 
</font><font color="#000000">MZ..............
00000010 </font><font color="#0000FF">00000000 </font><font color="#004080">00010000 </font><font 
color="#0000FF">1E000000 </font><font color="#004080">01000000 </font><font color="#000000">................
00000020 </font><font color="#0000FF">00000000 </font><font color="#004080">00000000 </font><font 
color="#0000FF">00000000 </font><font color="#004080">00000000 </font><font color="#000000">................
00000030 </font><font color="#0000FF">00000000 </font><font color="#004080">00000000 </font><font 
color="#0000FF">00000000 </font><font color="#004080">00000000 </font><font color="#000000">................
</font>
</code></pre>

<hr>
<font size="-3">
Generated by <a href="http://www.bpsoft.com">Hex Workshop</a>
</font>
</body>

</html>

C Source:



// Generated by Hex Workshop
// HWS50A0 - Starting Offset: 0 (0x00000000) Length: 64 (0x00000040)

unsigned char rawData[64] = {
0x4D, 0x5A, 0xC6, 0x00, 0xB6, 0x00, 0x00, 0x00, 0x15, 0x04, 0x01, 0x00, 0xFF, 0xFF, 0x00, 0x00, 
0x00, 0x00, 0x00, 0x00, 0x00, 0x01, 0x00, 0x00, 0x1E, 0x00, 0x00, 0x00, 0x01, 0x00, 0x00, 0x00, 
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 
} ;



Data Viewer

Hex Workshop includes a Data Viewer, which is a floating palette displaying the cursor data as decimal values.    The 
Data Viewer interprets the hexadecimal data at the cursor position as a byte, unsigned byte, short, unsigned short, 
long, unsigned long, float, and double.    From the Data Viewer, you can modify the data at the cursor position by 
highlighting the data type/value you wish to change and hitting F2 or clicking on it again with mouse (as you would in 
the Windows Explorer) and editing the value.

The Data Viewer can be toggled on/off (shown/hidden) from the Options Menu and the Toolbar.



Page Setup

Hex Workshop provides the ability to print customized printouts (hex dumps) with a Page Setup feature.    Using the 
Page Setup users can use a custom header and/or footer, printer font, and margins.

Header/Footer:

The header and footer can consist of any valid text.    Using special codes (listed in the Page Setup dialog) users can 
print the filename or full path, current page number, total pages, and time and date in a number of different formats.    
In addition, any portion or all of the headers and footers can be left, center, or right justified using these special 
codes.

Font:

The font which is used to print all data.    This can be changed to any monospace font on the users system.    The 
default is Courier 12 point.

Margins:

The left, right, top, and bottom margin can be set for printouts.    The default is 0.50 inches for all margins.



Find/Replace Utility

The Find Utility (Alt+F3), located under the Edit menu, allows the user to search for a hex, ASCII, or decimal value 
within the file.    The Find Utility searches from the cursor position either down (forward) or up (backward) throughout 
the file.    If a hex value is the search target, it is assumed to be raw hex (no options are offered).    If a decimal value 
is the search target, options are given for data type (byte, short, long, etc.) and byte ordering (Intel vs. Motorola).    If 
an ASCII value is the search target, the options given are for a case sensitive search and to search for a Unicode 
string.    There is a toolbar button which can be used as a shortcut for the Find Utility.

The Find Again (F3) command, located under the Edit menu, searches for the next occurrence of the target hex or 
ASCII value within the file.    This Find Again is in the same direction beginning at the (new) cursor position, having 
the same effect as setting up and executing another identical Find.    If there are no existing Find parameters, the Find
Again brings up the original Find Dialog.      There is a toolbar button which can be used as a shortcut for Find Again.

The Replace Utility, located under the Edit menu, works in the same manner as the Find.    The Replace Utility allows 
for different sized search and replace strings, and has a Replace All option.    In addition, the Replace Utility offers an 
option to “Pad String with Nulls” when replacing ASCII.    This is useful if you are replacing a string with a shorter 
string and with to leave the file size intact.    The replace string will be padded with NULL chars until it is equal in size 
to the search string, before substituted.

Hex Workshop is set up to notify the user upon wrapping around the file during a Find, Find Again, or Replace 
execution (See General Preferences). 



Goto Utility

The Goto Utility (Alt+F5), located under the Edit menu, allows the user to logically move throughout the file.    The 
Goto Utility can be used to move from the beginning of the file, the cursor position, or the end of the file.    The 
number of bytes to move can be specified in either hex or decimal (with hex values always positive).    When moving 
from the cursor position a negative decimal value may be entered to move backwards (This is the only time a 
negative value is allowed.).    In moving back from the end of the file, a positive number moves back into the file.    
There is a toolbar button which can be used as a shortcut for Goto.

The Goto Again (F5) command, located under the Edit menu, is used to re-execute the last Goto command.    If the 
previous Goto was from the current position, then another Goto is executed moving the same amount of bytes in the 
same direction, having the same effect as setting up and executing another identical Goto.    If the previous Goto was 
from the beginning or end of file, then the dialog is brought up again with the previous values loaded.    If there are no 
existing Goto parameters, the Goto Again brings up the original Goto Dialog.

Hex Workshop is set up to notify the user upon wrapping around the file during a Goto or Goto Again execution (See 
General Preferences). 



Compare Tool

The Compare Tool (Alt+F7), located under the Tools menu, allows the user to compare two open files beginning at a 
specified location in both files.    The Compare Tool can be used to compare two different files or the same file 
beginning at different file offsets.

The Compare Again (F7) command, located under the Tools menu, is used to find the next difference in the two files 
being compared.    If there are no existing Compare parameters, the Compare Again brings up the original Compare 
Dialog.      

Hex Workshop is set up to notify the user upon wrapping around the file during a Compare or Compare Again 
execution (See General Preferences). 



Checksum Generator

The Checksum Generator (F12), located under the Tools menu, allows the user to generate checksums for an entire 
file or a selection.    The Checksum Generator currently calculates five types of checksums:

CheckSum-8: 8 bit count, adds all the bytes, initial value = 0x00
CheckSum-16: 16 bit count, adds all the bytes, initial value = 0x00
CRC-16: 16 bit CRC, polynomial = 0x8005, initial value = 0x0000 
CRC-16/CCITT: 16 bit CRC, polynomial = 0x1021, initial value = 0xFFFF
CRC-32: 32 bit CRC, polynomial = 0x04C11DB7, initial value = 0xFFFFFFFF

Hitting the generate button will perform these calculations, the user can then view the results in hex or decimal with 
the option for either 1's complement, 2's complement, or neither.



Drive (Sector) Editing

In addition to editing files, Hex Workshop can also edit Drive (Disk) Sectors.    By selecting "Open Drive" from under 
the Disk menu both mounted drives and BIOS disks (INT 13 floppy or fixed disk) can be edited.

Disk Editing Modes:

In drive mode (default), PC drives mounted by the operating system can be edited.    Drives of this type include, PC 
floppy disks, PC hard drives, or other external PC removable disks.    CD-ROM’s cannot be edited (currently), 
because the operating system mounts these in a different manner than other disks (more like network drives).

In raw mode (or disk mode), BIOS disks can edited.    BIOS disks include floppy disks and fixed disks.    Floppy disks 
available are A: and B:, while fixed disks are listed as 0x80 (first fixed disk), 0x81 (second fixed disk), etc..

The difference between the two modes is drives are accessed as logical volumes through the operating system by 
letters assigned by the operating system, and can only be edited if the operating system understands the disk format 
(file system).    Disks are accessed as physical media through the BIOS.    Raw (disk) mode allows editing of disks not
readable by the operating system as well as partition information stored on the disk but not residing in a logical 
volume.

Sector Editing:

Disk Editing information is supplied to the user including sector number currently being edited and total number of 
sectors on the disk in the title bar, and sector size, cursor position (within the sector), and hex data interpretation in 
the status bar.    From the toolbar the current sector and buttons to move forward or backward sectors are displayed.

Drive Editing is accomplished in the same manner as file editing, with a few exceptions.    Since the sector size is 
fixed, data cannot be inserted or deleted, only overwritten.    The Goto utility becomes a Goto Sector Utility allowing 
movement forward or backward in sectors from the beginning, end, or current sector of the drive/disk.    The Find 
Utility now operates on a range of sectors specified in the Find dialog, and Replace is disabled for sector editing.    
Finally the Compare Tool will compare (and wrap) within a sector not crossing sector boundaries.

Because of the slightly different nature of Drive Editing additional keycuts are available to help quickly move 
throughout the sectors of a disk.



Base Converter

Hex Workshop includes a Base Converter (BCONV16.EXE or BCONV32.EXE, in the 16 or 32 bit version, 
respectively).    The Base Converter converts from hex to decimal and decimal to hex (while displaying binary).    For a
conversion the user can specify byte order (Intel, Motorola, or Raw Hex) and Data Type (byte, unsigned byte, short, 
unsigned short, long, unsigned long, float, or double).

The Base Converter includes an Always on Top (Ctrl+A) option accessible from the system menu.

Note:    When entering hex values with the Byte Order set on Intel or Motorola, the Base Converter will only convert 
and display a decimal value when the number of digits is exactly the number appropriate for the selected Data Type.   
For example, if the Byte Order is set to Intel and the Data Type is set to unsigned short a decimal value will only be 
displayed when 4 hex digits are entered.    This is necessary to avoid assumptions on zero padding (right or left) 
before byte flipping.    When the Byte Order is set to Raw Hex, then a decimal value will be displayed when the 
number of digits is less than or equal to that for the selected Data Type (left padding of zeros is assumed).



Hex Calculator

Hex Workshop includes a Hex Calculator (CALC16.EXE or CALC32.EXE, in the 16 or 32 bit version, respectively).    
The Hex Calculator operates in two modes; arithmetic mode and bit manipulation mode.    The arithmetic mode 
supports addition (+), subtraction (-), multiplication (*), and division (/)    and the bit manipulation mode supports 
logical or (|), logical and (&), exclusive or (^), negation (~), left shift (<<), and right shift (>>).    Both modes operate on 
hex or decimal unsigned long values and do not allow negative numbers or fractions.

The left shift (<<) and right shift (>>) operators require a second value specifying the amount of bytes to shift.    For 
example to left shift 0xFF by 1 bit, enter FF << 1 =., by 4 bits enter FF << 4 =.    Further it should be noted the left and 
right shift do not rotate the most significant and least significant bit (because that would be dependent on data type).

The mode can be toggled from the system menu or using the Ctrl+S keycut.    The calculator can be toggled between 
hex and decimal by clicking on the "HEX" or "DEC" in the display or using the spacebar, and the calculator can be 
switched into hex or decimal mode using the keycuts, Ctrl+H and Ctrl+D, respectively.

The Calculator includes an Always on Top (Ctrl+A) option accessible from the system menu.



Windows ANSI (ASCII) Character Set

Dec Hex Char Code

0 00 € NUL
1 01 € SOH
2 02 € STX
3 03 € ETX
4 04 € EOT
5 05 € ENQ
6 06 € ACK
7 07 € BEL
8 08 € BS
9 09 € HT
10 0A € LF
11 0B € VT
12 0C € FF
13 0D € CR
14 0E € SO
15 0F € SI
16 10 € SLE
17 11 € CS1
18 12 € DC2
19 13 € DC3
20 14 € DC4
21 15 € NAK
22 16 € SYN
23 17 € ETB
24 18 € CAN
25 19 € EM
26 1A € SIB
27 1B € ESC
28 1C € FS
29 1D € GS
30 1E € RS
31 1F € US
32 20 (space)
33 21 !
34 22 "
35 23 #
36 24 $
37 25 %
38 26 &
39 27 '
40 28 (
41 29 )
42 2A *
43 2B +
44 2C ,
45 2D -



46 2E .
47 2F /
48 30 0
49 31 1
50 32 2
51 33 3
52 34 4
53 35 5
54 36 6
55 37 7
56 38 8
57 39 9
58 3A :
59 3B ;
60 3C <
61 3D =
62 3E >
63 3F ?
64 40 @
65 41 A
66 42 B
67 43 C
68 44 D
69 45 E
70 46 F
71 47 G
72 48 H
73 49 I
74 4A J
75 4B K
76 4C L
77 4D M
78 4E N
79 4F O
80 50 P
81 51 Q
82 52 R
83 53 S
84 54 T
85 55 U
86 56 V
87 57 W
88 58 X
89 59 Y
90 5A Z
91 5B [
92 5C \
93 5D ]
94 5E ^
95 5F _
96 60 `
97 61 a
98 62 b
99 63 c
100 64 d
101 65 e



102 66 f
103 67 g
104 68 h
105 69 i
106 6A j
107 6B k
108 6C l
109 6D m
110 6E n
111 6F o
112 70 p
113 72 q
114 72 r
115 73 s
116 74 t
117 75 u
118 76 v
119 77 w
120 78 x
121 79 y
122 7A z
123 7B {
124 7C |
125 7D }
126 7E ~
127 7F �
128 80 €
129 81 
130* 82 ‚
131* 83 ƒ
132* 84 „
133* 85 …
134* 86 †
135* 87 ‡
136* 88 ˆ
137* 89 ‰
138* 8A Š
139* 8B ‹
140* 8C Œ
141 8D 
142 8E Ž
143 8F 
144 90 
145 91 ‘
146 92 ’
147* 93 “
148* 94 ”
149* 95 •
150* 96 –
151* 97 —
152* 98 ˜
153* 99 ™
154* 9A š
155* 9B ›
156* 9C œ
157 9D 



158 9E ž
159* 9F Ÿ
160 A0  
161 A1 ¡
162 A2 ¢
163 A3 £
164 A4 ¤
165 A5 ¥
166 A6 ¦
167 A7 §
168 A8 ¨
169 A9 ©
170 AA ª
171 AB «
172 AC ¬
173 AD
174 AE ®
175 AF ¯
176 B0 °
177 B1 ±
178 B2 ²
179 B3 ³
180 B4 ´
181 B5 µ
182 B6 ¶
183 B7 ·
184 B8 ¸
185 B9 ¹
186 BA º
187 BB »
188 BC ¼
189 BD ½
190 BE ¾
191 BF ¿
192 C0 À
193 C1 Á
194 C2 Â
195 C3 Ã
196 C4 Ä
197 C5 Å
198 C6 Æ
199 C7 Ç
200 C8 È
201 C9 É
202 CA Ê
203 CB Ë
204 CC Ì
205 CD Í
206 CE Î
207 CF Ï
208 D0 Ð
209 D1 Ñ
210 D2 Ò
211 D3 Ó
212 D4 Ô
213 D5 Õ



214 D6 Ö
215 D7 ×
216 D8 Ø
217 D9 Ù
218 DA Ú
219 DB Û
220 DC Ü
221 DD Ý
222 DE Þ
223 DF ß
224 E0 à
225 E1 á
226 E2 â
227 E3 ã
228 E4 ä
229 E5 å
230 E6 æ
231 E7 ç
232 E8 è
233 E9 é
234 EA ê
235 EB ë
236 EC ì
237 ED í
238 EE î
239 EF ï
240 F0 ð
241 F1 ñ
242 F2 ò
243 F3 ó
244 F4 ô
245 F5 õ
246 F6 ö
247 F7 ÷
248 F8 ø
249 F9 ù
250 FA ú
251 FB û
252 FC ü
253 FD ý
254 FE þ
255 FF ÿ

* Windows True Type Fonts Only



DOS Character Set

Dec Hex Char Code

0 00 € NUL
1 01 € SOH
2 02 € STX
3 03 € ETX
4 04 € EOT
5 05 € ENQ
6 06 € ACK
7 07 € BEL
8 08 € BS
9 09 € HT
10 0A € LF
11 0B € VT
12 0C € FF
13 0D € CR
14 0E € SO
15 0F € SI
16 10 € SLE
17 11 € CS1
18 12 € DC2
19 13 € DC3
20 14 € DC4
21 15 € NAK
22 16 € SYN
23 17 € ETB
24 18 € CAN
25 19 € EM
26 1A € SIB
27 1B € ESC
28 1C € FS
29 1D € GS
30 1E € RS
31 1F € US
32 20 (space)
33 21 !
34 22 "
35 23 #
36 24 $
37 25 %
38 26 &
39 27 '
40 28 (
41 29 )
42 2A *
43 2B +
44 2C ,
45 2D -



46 2E .
47 2F /
48 30 0
49 31 1
50 32 2
51 33 3
52 34 4
53 35 5
54 36 6
55 37 7
56 38 8
57 39 9
58 3A :
59 3B ;
60 3C <
61 3D =
62 3E >
63 3F ?
64 40 @
65 41 A
66 42 B
67 43 C
68 44 D
69 45 E
70 46 F
71 47 G
72 48 H
73 49 I
74 4A J
75 4B K
76 4C L
77 4D M
78 4E N
79 4F O
80 50 P
81 51 Q
82 52 R
83 53 S
84 54 T
85 55 U
86 56 V
87 57 W
88 58 X
89 59 Y
90 5A Z
91 5B [
92 5C \
93 5D ]
94 5E ^
95 5F _
96 60 `
97 61 a
98 62 b
99 63 c
100 64 d
101 65 e



102 66 f
103 67 g
104 68 h
105 69 i
106 6A j
107 6B k
108 6C l
109 6D m
110 6E n
111 6F o
112 70 p
113 72 q
114 72 r
115 73 s
116 74 t
117 75 u
118 76 v
119 77 w
120 78 x
121 79 y
122 7A z
123 7B {
124 7C |
125 7D }
126 7E ~
127 7F �
128 80 Ç
129 81 ü
130 82 é
131 83 â
132 84 ä
133 85 à
134 86 å
135 87 ç
136 88 ê
137 89 ë
138 8A è
139 8B ï
140 8C î
141 8D ì
142 8E Ä
143 8F Å
144 90 É
145 91 œ
146 92 Æ
147 93 ô
148 94 ö
149 95 ò
150 96 û
151 97 ù
152 98 ÿ
153 99 Ö
154 9A Ü
155 9B ¢
156 9C £
157 9D ¥



158 9E
159 9F ƒ
160 A0 á
161 A1 í
162 A2 ó
163 A3 ú
164 A4 ñ
165 A5 Ñ
166 A6 ª
167 A7 º
168 A8 ¿
169 A9 ¬
170 AA ½
171 AB ¼
172 AC ¡
173 AD «
174 AE »
175 AF
176 B0
177 B1
178 B2
179 B3
180 B4
181 B5
182 B6
183 B7
184 B8
185 B9
186 BA
187 BB
188 BC
189 BD
190 BE
191 BF
192 C0
193 C1
194 C2
195 C3
196 C4 —
197 C5
198 C6
199 C7
200 C8
201 C9
202 CA
203 CB
204 CC
205 CD
206 CE
207 CF
208 D0
209 D1
210 D2
211 D3
212 D4
213 D5



214 D6
215 D7
216 D8
217 D9
218 DA
219 DB
220 DC
221 DD
222 DE
223 DF
224 E0
225 E1 ß
226 E2
227 E3
228 E4
229 E5
230 E6 µ
231 E7
232 E8
233 E9
234 EA
235 EB
236 EC
237 ED
238 EE
239 EF
240 F0
241 F1
242 F2
243 F3
244 F4
245 F5
246 F6 ÷
247 F7
248 F8 º
249 F9 •
250 FA ·
251 FB
252 FC
253 FD ²
254 FE
255 FF



EBCDIC Character Set

Dec Hex Char Code

0 00 € NUL
1 01 € SOH
2 02 € STX
3 03 € ETX
4 04 € PF
5 05 € HT
6 06 € LC
7 07 € DEL
8 08
9 09 € RLF
10 0A € SMM
11 0B € VT
12 0C € FF
13 0D € CR
14 0E € S0
15 0F € S1
16 10 € DLE
17 11 € DC1
18 12 € DC2
19 13 € DC3
20 14 € RES
21 15 € NL
22 16 € BS
23 17 € IL
24 18 € CAN
25 19 € EM
26 1A € CC
27 1B
28 1C € IFS
29 1D € IGS
30 1E € IRS
31 1F € IUS
32 20 € DS
33 21 € SOS
34 22 € FS
35 23
36 24 € BYP
37 25 € LF
38 26 € ETB
39 27 € ESC
40 28
41 29
42 2A € SM
43 2B
44 2C
45 2D € ENQ



46 2E € ACK
47 2F € BEL
48 30
49 31
50 32 € SYN
51 33
52 34 € PN
53 35 € RS
54 36 € UC
55 37 € EOT
56 38
57 39
58 3A
59 3B
60 3C € DC4
61 3D € NAK
62 3E
63 3F € SUB
64 40 € SP
65 41
66 42
67 43
68 44
69 45
70 46
71 47
72 48
73 49
74 4A ¢
75 4B .
76 4C <
77 4D (
78 4E +
79 4F |
80 50 &
81 51
82 52
83 53
84 54
85 55
86 56
87 57
88 58
89 59
90 5A !
91 5B $
92 5C *
93 5D )
94 5E ;
95 5F ¬
96 60 -
97 61
98 62
99 63
100 64
101 65



102 66
103 67
104 68
105 69
106 6A |
107 6B ‘
108 6C %
109 6D _
110 6E >
111 6F ?
112 70
113 72
114 72
115 73
116 74
117 75
118 76
119 77
120 78
121 79 \
122 7A :
123 7B #
124 7C @
125 7D ‘
126 7E =
127 7F “
128 80
129 81 a
130* 82 b
131* 83 c
132* 84 d
133* 85 e
134* 86 f
135* 87 g
136* 88 h
137* 89 i
138* 8A
139* 8B
140* 8C
141 8D
142 8E
143 8F
144 90
145 91 j
146 92 k
147* 93 l
148* 94 m
149* 95 n
150* 96 o
151* 97 p
152* 98 q
153* 99 r
154* 9A
155* 9B
156* 9C
157 9D



158 9E
159* 9F
160 A0
161 A1 ~
162 A2 s
163 A3 t
164 A4 u
165 A5 v
166 A6 w
167 A7 x
168 A8 y
169 A9 z
170 AA
171 AB
172 AC
173 AD
174 AE
175 AF
176 B0
177 B1
178 B2
179 B3
180 B4
181 B5
182 B6
183 B7
184 B8
185 B9
186 BA
187 BB
188 BC
189 BD
190 BE
191 BF
192 C0 {
193 C1 A
194 C2 B
195 C3 C
196 C4 D
197 C5 E
198 C6 F
199 C7 G
200 C8 H
201 C9 I
202 CA
203 CB
204 CC
205 CD
206 CE
207 CF
208 D0 }
209 D1 J
210 D2 K
211 D3 L
212 D4 M
213 D5 N



214 D6 O
215 D7 P
216 D8 Q
217 D9 R
218 DA
219 DB
220 DC
221 DD
222 DE
223 DF
224 E0 \
225 E1
226 E2 S
227 E3 T
228 E4 U
229 E5 V
230 E6 W
231 E7 X
232 E8 Y
233 E9 Z
234 EA
235 EB
236 EC
237 ED
238 EE
239 EF
240 F0 0
241 F1 1
242 F2 2
243 F3 3
244 F4 4
245 F5 5
246 F6 6
247 F7 7
248 F8 8
249 F9 9
250 FA
251 FB
252 FC
253 FD
254 FE
255 FF



Macintosh Character Set

Dec Hex Char Code

0 00 € NUL
1 01 € SOH
2 02 € STX
3 03 € ETX
4 04 € EOT
5 05 € ENQ
6 06 € ACK
7 07 € BEL
8 08 € BS
9 09 € HT
10 0A € LF
11 0B € VT
12 0C € FF
13 0D € CR
14 0E € SO
15 0F € SI
16 10 € SLE
17 11 € CS1
18 12 € DC2
19 13 € DC3
20 14 € DC4
21 15 € NAK
22 16 € SYN
23 17 € ETB
24 18 € CAN
25 19 € EM
26 1A € SIB
27 1B € ESC
28 1C € FS
29 1D € GS
30 1E € RS
31 1F € US
32 20 (space)
33 21 !
34 22 "
35 23 #
36 24 $
37 25 %
38 26 &
39 27 '
40 28 (
41 29 )
42 2A *
43 2B +
44 2C ,
45 2D -



46 2E .
47 2F /
48 30 0
49 31 1
50 32 2
51 33 3
52 34 4
53 35 5
54 36 6
55 37 7
56 38 8
57 39 9
58 3A :
59 3B ;
60 3C <
61 3D =
62 3E >
63 3F ?
64 40 @
65 41 A
66 42 B
67 43 C
68 44 D
69 45 E
70 46 F
71 47 G
72 48 H
73 49 I
74 4A J
75 4B K
76 4C L
77 4D M
78 4E N
79 4F O
80 50 P
81 51 Q
82 52 R
83 53 S
84 54 T
85 55 U
86 56 V
87 57 W
88 58 X
89 59 Y
90 5A Z
91 5B [
92 5C \
93 5D ]
94 5E ^
95 5F _
96 60 `
97 61 a
98 62 b
99 63 c
100 64 d
101 65 e



102 66 f
103 67 g
104 68 h
105 69 i
106 6A j
107 6B k
108 6C l
109 6D m
110 6E n
111 6F o
112 70 p
113 72 q
114 72 r
115 73 s
116 74 t
117 75 u
118 76 v
119 77 w
120 78 x
121 79 y
122 7A z
123 7B {
124 7C |
125 7D }
126 7E ~
127 7F �
128 80 Ä
129 81 Å
130 82 Ç
131 83 É
132 84 Ñ
133 85 Ö
134 86 Ü
135 87 á
136 88 à
137 89 â
138 8A ä
139 8B ã
140 8C å
141 8D ç
142 8E é
143 8F è
144 90 ê
145 91 ë
146 92 í
147 93 ì
148 94 î
149 95 ï
150 96 ñ
151 97 ó
152 98 ò
153 99 ô
154 9A ö
155 9B õ
156 9C ú
157 9D ù



158 9E û
159 9F ü
160 A0 †
161 A1 °
162 A2 ¢
163 A3 £
164 A4 §
165 A5 •
166 A6 ¶
167 A7 ß
168 A8 ®
169 A9 ©
170 AA ™
171 AB ´
172 AC ¨
173 AD
174 AE Æ
175 AF Ø
176 B0
177 B1 ±
178 B2
179 B3
180 B4 ¥
181 B5 µ
182 B6
183 B7
184 B8
185 B9
186 BA
187 BB ª
188 BC º
189 BD
190 BE æ
191 BF ø
192 C0 ¿
193 C1 ¡
194 C2 ¬
195 C3
196 C4 ƒ
197 C5
198 C6
199 C7 «
200 C8 »
201 C9 …
202 CA  
203 CB À
204 CC Ã
205 CD Õ
206 CE Œ
207 CF œ
208 D0 –
209 D1 —
210 D2 “
211 D3 ”
212 D4 ‘
213 D5 ’



214 D6 ÷
215 D7
216 D8 ÿ
217 D9 Ÿ
218 DA /
219 DB ¤
220 DC ‹
221 DD ›
222 DE
223 DF
224 E0 ‡
225 E1 ·
226 E2 ‚
227 E3 „
228 E4 ‰
229 E5 Â
230 E6 Ê
231 E7 Á
232 E8 Ë
233 E9 È
234 EA Í
235 EB Î
236 EC Ï
237 ED Ì
238 EE Ó
239 EF Ô
240 F0
241 F1 Ò
242 F2 Ú
243 F3 Ü
244 F4 Ù
245 F5
246 F6 ˆ
247 F7
248 F8 ¯
249 F9
250 FA ·
251 FB
252 FC ¸
253 FD
254 FE
255 FF



Data Types

Type Name Bytes Range of Values
(signed) byte 1 -128 to 127
unsigned byte 1 0 to 255

(signed) short 2 -32,768 to 32,767
unsigned short 2 0 to 65,535

(signed) long 4 -2,147,483,648 to 2,147,483,647
unsigned long 4 0 to 4,294,967,295

float 4 3.4E +/- 38 
double 8 1.7E +/- 308
long double       10 1.2E +/- 4932 

Note:    Integers are shorts with 16 bit processors and longs with 32 bit processors.




